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法律声明
阿⾥云提醒您在阅读或使⽤本⽂档之前仔细阅读、充分理解本法律声明各条款的内容。如果您阅读
或使⽤本⽂档，您的阅读或使⽤⾏为将被视为对本声明全部内容的认可。
1. 您应当通过阿⾥云⽹站或阿⾥云提供的其他授权通道下载、获取本⽂档，且仅能⽤于⾃⾝的合法

合规的业务活动。本⽂档的内容视为阿⾥云的保密信息，您应当严格遵守保密义务；未经阿⾥云
事先书⾯同意，您不得向任何第三⽅披露本⼿册内容或提供给任何第三⽅使⽤。

2. 未经阿⾥云事先书⾯许可，任何单位、公司或个⼈不得擅⾃摘抄、翻译、复制本⽂档内容的部分
或全部，不得以任何⽅式或途径进⾏传播和宣传。

3. 由于产品版本升级、调整或其他原因，本⽂档内容有可能变更。阿⾥云保留在没有任何通知或者
提⽰下对本⽂档的内容进⾏修改的权利，并在阿⾥云授权通道中不时发布更新后的⽤⼾⽂档。您
应当实时关注⽤⼾⽂档的版本变更并通过阿⾥云授权渠道下载、获取最新版的⽤⼾⽂档。

4. 本⽂档仅作为⽤⼾使⽤阿⾥云产品及服务的参考性指引，阿⾥云以产品及服务的”现状“、“有
缺陷”和“当前功能”的状态提供本⽂档。阿⾥云在现有技术的基础上尽最⼤努⼒提供相应的介
绍及操作指引，但阿⾥云在此明确声明对本⽂档内容的准确性、完整性、适⽤性、可靠性等不作
任何明⽰或暗⽰的保证。任何单位、公司或个⼈因为下载、使⽤或信赖本⽂档而发⽣任何差错或
经济损失的，阿⾥云不承担任何法律责任。在任何情况下，阿⾥云均不对任何间接性、后果性、
惩戒性、偶然性、特殊性或刑罚性的损害，包括⽤⼾使⽤或信赖本⽂档而遭受的利润损失，承担
责任（即使阿⾥云已被告知该等损失的可能性）。

5. 阿⾥云⽹站上所有内容，包括但不限于著作、产品、图⽚、档案、资讯、资料、⽹站架构、⽹
站画⾯的安排、⽹⻚设计，均由阿⾥云和/或其关联公司依法拥有其知识产权，包括但不限于商
标权、专利权、著作权、商业秘密等。⾮经阿⾥云和/或其关联公司书⾯同意，任何⼈不得擅⾃
使⽤、修改、复制、公开传播、改变、散布、发⾏或公开发表阿⾥云⽹站、产品程序或内容。
此外，未经阿⾥云事先书⾯同意，任何⼈不得为了任何营销、⼴告、促销或其他⽬的使⽤、公
布或复制阿⾥云的名称（包括但不限于单独为或以组合形式包含”阿⾥云”、Aliyun”、“万
⽹”等阿⾥云和/或其关联公司品牌，上述品牌的附属标志及图案或任何类似公司名称、商号、
商标、产品或服务名称、域名、图案标⽰、标志、标识或通过特定描述使第三⽅能够识别阿⾥云
和/或其关联公司）。

6. 如若发现本⽂档存在任何错误，请与阿⾥云取得直接联系。
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通⽤约定
格式 说明 样例

该类警⽰信息将导致系统重⼤变更甚⾄
故障，或者导致⼈⾝伤害等结果。 禁⽌:

重置操作将丢失⽤⼾配置数据。
该类警⽰信息可能导致系统重⼤变更甚
⾄故障，或者导致⼈⾝伤害等结果。 警告:

重启操作将导致业务中断，恢复业务所需
时间约10分钟。

⽤于补充说明、最佳实践、窍⻔等，不
是⽤⼾必须了解的内容。 说明:

您也可以通过按Ctrl + A选中全部⽂件。
> 多级菜单递进。 设置 > ⽹络 > 设置⽹络类型
粗体 表⽰按键、菜单、⻚⾯名称等UI元素。 单击 确定。
courier

字体
命令。 执⾏ cd /d C:/windows 命令，进

⼊Windows系统⽂件夹。
斜斜 表⽰参数、变量。 bae log list --instanceid

 Instance_ID
[]或者[a|b
]

表⽰可选项，⾄多选择⼀个。 ipconfig [-all|-t]

{}或者{a|b
}

表⽰必选项，⾄多选择⼀个。 swich {stand | slave}
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1 客⼾端
本⽂为您介绍如何使⽤客⼾端命令⾏⼯具使⽤MaxCompute服务的基础功能。
在使⽤MaxCompute客⼾端前，请⾸先安装并配置客⼾端 。

说明:
• 请不要依赖客⼾端的输出格式来做任何的解析⼯作。客⼾端的输出格式不承诺向前兼容，不同

版本间的客⼾端命令格式及⾏为有差异。
• 关于客⼾端的基本命令介绍，请参⻅基本命令。
• 新版客⼾端：点击此处即可下载新版客⼾端。关于不同环境下客⼾端的安装配置信息请参⻅安

装并配置客⼾端。
• 客⼾端从0.28.0版开始⽀持JDK 1.9，这之前的版本只能⽤JDK 1.8。
• 客⼾端从0.27.0版本开始⽀持MaxCompute 2.0新数据类型。

安装并配置好客⼾端后，您可借助命令⾏⼯具进⾏以下操作。
获取帮助

若想显⽰客⼾端的帮助信息，命令格式如下所⽰。
odps@ >./bin/odpscmd -h;

您也可以在交互模式下键⼊h;或help;（不区分⼤小写）。
客⼾端还提供了help [keyword];命令，可获取到与关键字有关的命令提⽰。例如：输⼊help 

table;可以得到与table操作相关的命令提⽰，如下所⽰。
odps@ odps> help table;
Usage: alter table  merge smallfiles
Usage: show tables [in ]
      list|ls tables [-p,-project ]
Usage: describe|desc [.] [partition()]
Usage: read [.] [([,..])] [PARTITION ()] [line_num]

启动参数
在启动时，您可指定⼀系列参数，如下所⽰。
Usage: odpscmd [OPTION]...
where options include:
    --help (-h)for help
    --project= use project
    --endpoint= set endpoint
    -u  -p  user name and password
    -k  will skip begining queries and start from specified position

⽂档版本：20190701 1
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    -r  set retry times
    -f <"file_path;"> execute command in file
    -e <"command;[command;]..."> execute command, include sql command
    -C will display job counters

以-f参数为例，操作如下：
1. 准备本地脚本⽂件script.txt，假设存放在D盘，⽂件内容如下所⽰。

DROP TABLE IF EXISTS test_table_mj;
CREATE TABLE test_table_mj (id string, name string);
DROP TABLE test_table_mj;

2. 打开您的CMD命令⾏⼯具，进⼊odpscmd客⼾端所在路径，运⾏以下命令。
odpscmd\bin>odpscmd -f D:/script.txt;

3. 您也可以使⽤上述命令批量建表或删表。
交互模式

直接运⾏客⼾端即可进⼊到交互模式，如下所⽰。
[admin: ~]$odpscmd
Aliyun ODPS Command Line Tool
Version 1.0
@Copyright 2012 Alibaba Cloud Computing Co., Ltd. All rights reserved.
odps@ odps> INSERT OVERWRITE TABLE DUAL SELECT * FROM DUAL;

在光标位置输⼊命令（以分号作为语句的结束标志），回⻋即可运⾏。
续跑

• 在⽤-e或-f 模式运⾏时，如果有多条语句，想从中间某条语句开始运⾏，可以指定参数-k， 表
⽰忽略前⾯的语句，从指定位置的语句开始运⾏。当指定参数<=0 时，从第⼀条语句开始执⾏。

• 每个以分号分隔的语句被视为⼀条有效语句，在运⾏时会打印出当前运⾏成功或者失败的是第⼏
条语句。

⽰例
假设⽂件/tmp/dual.sql中有三条SQL语句，如下所⽰。
drop table dual;
create table dual (dummy string);
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insert overwrite table dual select count(*) from dual;

如果想忽略前两条语句，直接从第三条语句开始执⾏，则命令格式如下所⽰。
odpscmd -k 3 -f dual.sql

获取当前登录⽤⼾
若想获取当前登录⽤⼾，命令格式如下所⽰。
whoami;

⽰例
odps@ hiveut>whoami;
Name: odpstest@aliyun.com
End_Point: http://service.odps.aliyun.com/api
Project: lijunsecuritytest

通过以上命令，即可获取当前登录⽤⼾的云账号、使⽤的End_Point配置和项⽬名。
退出

若想退出客⼾端，命令格式如下所⽰。
odps@ > quit;

您也可输⼊以下命令退出客⼾端。
odps@ > q;

⽂档版本：20190701 3
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2 MaxCompute Studio
2.1 认识Studio

MaxCompute Studio是阿⾥云MaxCompute平台提供的安装在开发者客⼾端的⼤数据集成开发
环境⼯具，是⼀套基于流⾏的集成开发平台IntelliJ IDEA的开发插件，帮助您便捷、快速地进⾏数据
开发。本⽂将为您介绍MaxCompute Studio的功能界⾯和常⽤的应⽤场景。

基本⽤⼾界⾯
MaxCompute Studio是IntelliJ IDEA平台上的⼀套插件，共享了IntelliJ IDEA的基本开发界
⾯。
MaxCompute Studio在IntelliJ的基础上提供以下功能：
• SQL编辑器（SQL Editor）：提供SQL语法⾼亮、代码补全、实时错误提⽰、本地编译、作业

提交等功能。
编译器视图（Compiler View）：显⽰本地编译的提⽰信息和错误信息，在编辑器中定位代
码。

• 项⽬空间浏览器（Project Explorer)：连接MaxCompute项⽬空间，浏览项⽬空间表结构、⾃
定义函数、资源⽂件。
表详情视图（Table Details View）：提供表、视图等资源的详情显⽰和⽰例数据（Sample 
Data）。

• 作业浏览器（Job Explorer）：浏览、搜索MaxCompute的历史作业信息。
- 作业详情视图（Job Details View）：显⽰作业的运⾏详细信息，包括执⾏计划和每个执⾏

任务的详细信息，Logview⼯具能够显⽰的全部信息。
- 作业输出视图（Job Output View）：显⽰正在运⾏的作业的输出信息。
- 作业结果视图（Job Result View）：显⽰SELECT作业的输出结果。

• MaxCompute控制台（MaxCompute Console）：集成了MaxCompute客⼾端，可以输⼊和
执⾏MaxCompute客⼾端命令。

连接MaxCompute项⽬空间
Studio的⼤部分功能需要您⾸先创建项⽬空间连接。建⽴项⽬空间连接后，即可在项⽬空间浏览
器中查看相关的数据结构和资源信息。Studio会⾃动为每⼀个项⽬空间连接建⽴⼀个本地的元数据
备份，以提⾼对MaxCompute元数据的访问频率和降低延时。
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说明:
• 您需要先指定项⽬空间链接，才可通过Studio进⾏编辑SQL脚本、提交作业、查看Job信息、

打开MaxCompute控制台等操作，因此⾸先创建⼀个MaxCompute项⽬空间的连接是⾮常必
要的。

• MaxCompute项⽬空间的更多详情请参⻅项⽬空间。
• 在Studio中管理项⽬空间的更多详情请参⻅项⽬空间连接。

管理数据
您可以通过Studio的项⽬空间浏览器快速浏览项⽬空间的表结构、⾃定义函数、资源⽂件。通过树
形控件，可以列出所有项⽬空间连接下的数据表、列、分区列、虚拟视图、⾃定义函数名称、函数
签名、资源⽂件及类型等，并⽀持快速定位。
双击某个数据表，即可打开表详情视图，查看数据表的元信息、表结构和⽰例数据。如果您没有项
⽬空间的相应权限，Studio会提⽰对应的错误信息。
Studio集成了MaxCompute Tunnel⼯具，可以⽀持本地数据的上传和下载，更多详情请参⻅导⼊并
导出数据。

编写SQL脚本
您可以在Studio中编写MaxCompute SQL脚本，⾮常⽅便。
1. 打开Studio，导航⾄File > New > Project或者File > New > Module…。
2. 创建⼀个MaxCompute Studio类型的项⽬或者模块。
3. 导航⾄File > New > MaxCompute Script 或者右击菜单New > MaxCompute Script，即可

创建⼀个MaxCompute SQL脚本⽂件。

说明:
创建MaxCompute SQL脚本时，Studio会提⽰您选择⼀个关联的MaxCompute项⽬空
间，您也可以通过SQL编辑器上的⼯具条最右侧的项⽬空间选取器进⾏更改，编辑器会根
据SQL脚本关联的项⽬空间对SQL语句⾃动进⾏元数据（⽐如表结构等）的检查并汇报错
误，提交运⾏时也会发送到关联的项⽬空间执⾏。更多详情请参⻅编写SQL脚本。

SQL代码智能提⽰
Studio提供的SQL编辑器可以根据您写⼊的代码，智能提⽰SQL语句的语法错误、类型匹配错误或
者警告等，实时地标注在代码上。如下图所⽰：
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通过代码补全功能，Studio可以根据代码上下⽂，提⽰您项⽬空间名称、表、字段、函数、类型、
代码关键词等，并根据您的选择，⾃动补全代码。如下图所⽰：

编译和提交作业
• 编译作业

单击SQL编辑器⼯具条上的  图标，可以对SQL脚本执⾏本地编译，如果有语法或者语义错
误，编译器窗口会报告错误。

• 提交作业
单击SQL编辑器⼯具条上的 图标，会在本地编译之后，把SQL脚本提交
到MaxCompute指定的项⽬空间排队执⾏。
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查看历史作业
打开作业浏览器，您即可查看指定项⽬空间上近期执⾏的作业。

说明:
这个列表只能显⽰以当前连接使⽤的⽤⼾ID提交的作业。

双击其中⼀个作业，便可查看作业的的详情信息。如下图所⽰：
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如果知道⼀个任务的Logview URL，可以导航⾄MaxCompute > Open Logview，打开该任务
的详情⻚⾯。

开发MapReduce和UDF
Studio还⽀持MapReduce和Java UDF的开发。

连接MaxCompute客⼾端
Studio集成了最新版本的MaxCompute客⼾端，您也可以在Studio的配置⻚⾯ 中指定本地已经安
装好的MaxCompute客⼾端路径。
您在项⽬空间浏览器中选定⼀个项⽬空间，右键单击菜单选择Open in Console即可打
开MaxCompute控制台窗口。
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后续步骤
现在，您已经学习了MaxCompute Studio的功能界⾯和常⽤的应⽤场景，您可以继续学习下⼀个
教程。在该教程中您将学习如何安装MaxCompute Studio。详情请参⻅安装IntelliJ IDEA。

2.2 项⽬空间连接管理
MaxCompute Studio的⼀个核⼼功能是浏览MaxCompute项⽬空间（Project）的资源，包
括Table、UDF、Resource等。要想实现这⼀功能，⾸先需要创建项⽬空间连接。

前提条件
由于使⽤IntelliJ的Tool Windows必须先打开某个IntelliJ project，而配置MaxCompute
Project需要进⼊IntelliJ界⾯Tool Windows中的MaxCompute Project Explorer，所以在
创建MaxCompute Project连接前，您可以⾸先添加或者导⼊⼀个IntelliJ project。本⽂将以
在Windows下新增project为例。
运⾏IntelliJ IDEA后，单击New > Project，选择弹出⻚⾯中的MaxCompute Studio，单
击Next。
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填写Project name，单击Finish。
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创建MaxCompute项⽬链接
建议您根据⾃⼰的Region配置MaxCompute项⽬连接，否则会出现⽆法访问等错误。您可以参
考配置Endpoint配置⾃⼰的Endpoint和Region。
操作步骤：
1. 单击菜单中的View选项，选择Tool Windows。
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2. 单击弹出⻚⾯中的Project Explorer

3. 单击左上⻆的+，选择AddprojectfromaccessId/Key模式，添加⼀个MaxCompute
Project。
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4. 在Add MaxCompute Project对话框中，填⼊相关配置选项。

说明:
• 单击dialog左下⻆的?即可链接到在线⽂档。
• 若同步出现超时错误，可以在setting标签⻚酌情延⻓元数据同步到本地的超时时间。

5. 配置完成后，单击OK。左侧MaxCompute Project Explorer中会显⽰MaxCompute
Project的信息，可以通过⿏标单击查看该project中的表、视图、函数以及资源等信息。

查看/修改MaxCompute项⽬链接
在Project Explorer中，对需要修改的MaxCompupte项⽬右键选择Show|Modify project
properties。
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在弹出框中可以查看或修改该MaxCompute project的Connection和Setting。
后续操作

现在，您已经学习了如何新建、管理项⽬空间连接，您可以继续学习下⼀个教程。在该教程中您将
学习如何进⾏元数据查询、清理数据、上传下载数据等操作，来管理数据和资源。详情请参⻅ 管理
数据和资源。

2.3 ⼯具安装与版本信息
2.3.1 IntelliJ IDEA安装步骤

本⽂将为您介绍如何安装MaxCompute Studio的基础平台IntelliJ IDEA。
操作步骤

1. 单击 此链接，根据操作系统（Windows、macOS、Linux）下载对应IntelliJ IDEA版本。此
处我们以Windows操作系统安装为例，下载IntelliJ IDEA 14.1.4以上版本 。
⽀持Ultimate版本或免费的Community版本，PyCharm也⽀持。
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2. 下载完成后，双击安装程序，进⼊安装界⾯，单击Next。

3. 指定安装⽬录后，单击Next。
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4. 根据本地操作系统的版本选择需要安装32位或者64位的IntelliJ IDEA。
如何查看本地操作系统的版本:
a) 打开windows资源管理器，右击计算机 ，选择 属性。

b) 在弹出界⾯中查看操作系统位数。

16 ⽂档版本：20190701



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

5. 选择相应的系统类型，单击Next 。如下图所⽰：
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6. 单击Install，开始安装。如下图所⽰：
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7. 安装完成后，单击Finish 。

后续操作
现在，您已经学习了如何安装IntelliJ IDEA，可以继续学习如何安装MaxCompute Studio插
件。详情请参⻅安装 Studio 插件。

2.3.2 IntelliJ IDEA插件安装步骤
MaxCompute Studio是IntelliJ IDEA的插件，本⽂为您介绍如何安装MaxCompute Studio。

环境要求
IntelliJ IDEA⽀持在Windows， Mac， Linux操作系统上安装，硬件及系统环境要求请参⻅ 
Requirements for IntelliJ IDEA 。基于IntelliJ IDEA平台的MaxCompute Studio也可以安装在这
些操作系统的客⼾端上。
MaxCompute Studio对⽤⼾环境有以下要求：
• Windows，Mac OS，或者Linux系统客⼾端。
• 安装IntelliJ IDEA v18.2.4以上版本 （⽀持Ultimate版本、PyCharm版本和免费的 

Community 版本）。
• 已安装JRE 1.8 （最新的IntelliJ IDEA版本捆绑了JRE 1.8）。
• 已安装JDK 1.8 （可选：如果需要开发和调试Java UDF，则需安装 JDK）。
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说明:
客⼾端从0.28.0版开始⽀持JDK 1.9，在这之前的版本只⽀持JDK 1.8。

安装⽅式
MaxCompute Studio是IntelliJ IDEA的插件，有以下两种安装⽅式：
• 通过插件库在线安装（推荐）。
• 通过本地⽂件安装。

在线安装（推荐）
MaxCompute Studio插件已对全部公⽹⽤⼾开放，您可以通过IntelliJ官⽅插件库安装。
操作步骤
1. 在IntelliJ IDEA中打开插件配置⻚⾯ （Windows/Linux⽤⼾导航⾄ File >  Settings >

Plugins，Mac⽤⼾导航⾄IntelliJ IDEA  > Preferences > Plugins ）。
2. 单击Browse repositories…按钮，然后搜索MaxCompute Studio。
3. 找到MaxCompute Studio插件⻚⾯，单击绿⾊Install按钮进⾏安装。
4. 确认安装后，重新启动IntelliJ IDEA，完成安装。

本地安装
MaxCompute Studio也可以在本地环境中进⾏安装。
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操作步骤
1. 进⼊MaxCompute Studio 插件⻚⾯下载插件包。

⽂档版本：20190701 21
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2. 运⾏IntelliJ IDEA。
• 如果是第⼀次运⾏，会出现欢迎界⾯，单击欢迎界⾯中的configure（配置），选中弹出菜

单中的Plugins（插件），如下图所⽰：

• 如果不是第⼀次运⾏，可以依次单击菜单File > Settings > Plugins进⼊相同的界⾯，如下
图所⽰：
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3. 在插件⻚⾯，单击Install plugin from disk…（从本地磁盘安装插件），如下图所⽰：
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4. 在弹出窗口中，通过单击⽬录名称前的灰⾊图标进⾏导航，找到插件⽂件并选中，单击OK。
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5. 回到插件⾸⻚后，单击OK，开始安装本地插件。
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6. 安装完成后，弹出重新启动的提⽰窗口，单击Restart ，重新启动IntelliJ IDEA。

7. 重新启动后，界⾯如下所⽰：
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后续步骤
现在，您已经学习了如何安装MaxCompute Studio插件，您可以继续学习下⼀个教程。
在该教程中您将学习如何配置MaxCompute Project连接管理数据和资源。详情请参⻅ 新
建MaxCompute项⽬空间连接。

2.3.3 查看和更新版本
查看Studio版本信息

通过以下步骤查看Studio的版本信息：
1. 打开Settings/Preferences⻚⾯ （Windows Ctrl-Alt-S, Mac ⌘,）
2. 在对话框左侧边栏选择Plugins，然后搜索MaxCompute Studio

3. 可以看到MaxCompute Studio的版本号，以及版本的发布信息。
也可以在Setting⻚⾯左侧边栏选择MaxCompute Studio， 再找到当前版本号。

检查新版本
缺省配置下，MaxCompute Studio会⾃动检测新版本，当有新的可⽤版本时，会⾃动通知⽤⼾。

收到更新提⽰后，⽤⼾可以选择：
• 安装： 点击更新提⽰中的安装链接，将会⾃动下载并安装此新版本，安装完成后重启IntelliJ 

IDEA
• 配置： 点击更新提⽰中的配置链接，你可以配置是否⾃动检查新版本
如果关闭了⾃动更新功能，⽤⼾通过以下步骤可以检查MaxCompute Studio的版本更新并选择安
装：
1. 打开Settings/Preferences⻚⾯ （Windows Ctrl-Alt-S, Mac ⌘,）。
2. 在对话框左侧边栏选择MaxCompute Studio 。
3. 在Studio配置⻚⾯上，点击按钮Check new versions 。
4. 如果检测到新的可⽤版本，会提⽰⽤⼾新的版本号。 点击按钮Install new version可以安

装，重新启动 IntelliJ 完成安装。
可以通过Automatically checks for new versions复选框控制⾃动检查版本更新的开关。
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说明:
Studio当前最新版本对应的JAVA SDK版本是0.28.4及以上。

 
下⼀步

建⽴MaxCompute项⽬连接

2.4 管理数据和资源
2.4.1 浏览表及 UDF
查看表及函数

在项⽬空间浏览器（Project Explorer)窗口中可以快速浏览已添加连接的表、函数、资源等。使
⽤前提是添加MaxCompute项⽬连接。

浏览表和函数
要浏览项⽬空间的表和函数，使⽤以下步骤：
1. 打开项⽬空间浏览器（Project Explorer) ，即可以查看已添加的 Project节点树。

节点树上⽅是⼯具栏，包括：
• 增加Project：新增⼀个到MaxCompute项⽬空间的连接
• 删除Project：删除⼀个项⽬空间浏览器中的项⽬连接，对服务器端项⽬空间⽆影响
• 刷新元数据：从服务器端项⽬空间刷新元数据信息，刷新本地元数据缓存
• 展开节点：展开全部树节点
• 折叠节点：折叠全部树节点
• ⽤⼾反馈：提交⽤⼾反馈
• 在线⽂档：打开在线⽂档
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2. 双击或点击下拉箭头展开Tables节点，可列出该项⽬下的所有表（包括虚拟视图）。这⾥
的表名列表与⽤⼾执⾏show tables命令相等，需要⽤⼾在project下有list table权限。函
数（Functions）和资源（Resources）节点类似:

3. Studio会将服务上的项⽬元数据下载到本地，当服务端元数据有更新时，如新增了⼀张表，需
⼿动触发⼀次刷新，将变化的元数据重新加载到本地。 可以选择在项⽬（Project）或表（
Table）级别做刷新，步骤如下：
a. 选中相应的节点。
b. 点击⼯具栏上的刷新图标或在右键菜单中选择刷新菜单项。

查看表详细信息
⽤⼾可以通过Studio的 表详情视图（Table Details View） 查看数据表详细信息。
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1. 在节点树中，展开某个表名节点，可快速查看列名和类型：

2. 双击某个表或右键菜单Show Table Detail可以查看表的详细信息，包
括owner，size，column等元数据，表结构信息，以及data preview：
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3. 通过在Tables&Views右键菜单项Open specific entity ，可以指定表名显⽰详情（注意要完
整表名称）。另外如果⽤⼾没有project的list权限，而只有具体某张表的权限，也可以通过这
种⽅式将该表抓取下来。函数（Functions）及资源（Resources）类似。

Intellij IDE默认⽀持搜索，可展开表后直接敲击键盘模糊搜索。
4. studio也⽀持快速搜索某张表，可通过快捷键(win:Ctrl+Alt+Shift+N mac:#+⌘+O)唤出

navigate symbol，输⼊表名后回⻋即可。

可通过前置关键字(table:或function:或resource:)缩小搜索范围，譬如想搜索函数count，可
输⼊function:count。

5. 当想知道某张表在哪些script中⽤到时，可以右键该表，使⽤Find Usages功能。
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查看函数详细信息
1. 在Functions树UserDefined节点下可以展开某个函数节点，以显⽰该函数的⽅法签名。双

击某个函数节点（或在Resources下双击改函数对应的源码资源），可打开该函数对应的的代
码。

说明:
Java代码通过反编译jar获取，并⾮源码。Python UDF解析签名需要安
装pyodps(MaxCompute python sdk)，具体的先安装pip: sudo /usr/bin/python

 get-pip.py(请⾃⾏google下载get-pip.py)，然后安装pyodps: sudo /usr/bin/

python -m pip install pyodps。
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2. 在Functions树BuiltIn节点下分类显⽰了系统内置函数，展开显⽰签名，双击显⽰函数⽂档。

2.4.2 导⼊导出数据
Studio可以将CSV，TSV等格式的本地数据⽂件导⼊到MaxCompute表中，也可
将MaxCompute中表数据导出数据到本地⽂件。Studio是通过MaxCompute平台提供的批量数
据通道（Tunnel）功能完成的。

使⽤须知
• 导⼊导出数据采⽤MaxCompute Tunnel服务，因此要求Studio中添加的MaxCompute 

Project必须开通或配置了Tunnel服务。
• 导⼊导出表必须具备相应权限。
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导⼊数据
1. 打开项⽬空间浏览器（Project Explorer)窗口，在表名上点击右键或在表详细⻚⾯的Data

Preview中字段属性上右键，选择Import Data Into Table 。
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2. 在弹出的Import Data对话框中，选择导⼊数据⽂件的路径，列分隔符(可⾃定义输⼊)，⼤小限
制，错误容忍⾏数等参数，点击按钮OK 。

3. 提⽰Import Data Success，表⽰数据导⼊成功，可在表中查看导⼊的数据。
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导出数据
1. 启动导出表数据有两种⽅式：

• 在表名上右键，选择Export Data From Table。

如果您导出的是分区表，在导出时可输⼊分区值。
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• 在表详细⻚⾯的Data Preview中字段属性上右键，选择Export Data From Table。

2. 弹出Export Data对话框，选择导出数据⽂件的保存路径，列分隔符(可⾃定义输⼊)，⼤小限
制，错误容忍⾏数等，填写完成后点击OK。

3. 提⽰Export Data Success，表⽰数据导出成功，可在⽬标⽂件中看到导出的数据。
⽤⼾也可以在Table的Data Preview窗格中选择右键菜单Export Grid Data导出数据。
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说明:
在Data Preview窗格的导出数据功能仅导出显⽰在数据⽰例（Data Sample），而不⼀定是表中
的全部数据。

新类型导⼊导出
只需按照约定格式⽣成⽂本并存储为csv或tsv格式，就可通过studio导⼊到table。
下⾯将详细介绍各个数据类型的转换规则。
• 基本类型

1. TINYINT, SMALLINT, INT, BIGINT直接存储为整型字符串，数值超过类型边界会报错。
2. FLOAT, DOUBLE存储小数字符串或浮点形式，如：2.342 1E+7。
3. VARCHAR直接存储为字符串，超过上限会⾃动截断，不会报错。
4. STRING直接存储为字符串。
5. DECIMAL⽀持整形或浮点型的字符串。
6. BINARY需要将⼆进制数据编码为base64 string。
7. DATETIMEdate time需import dialog中指定的format格式保持⼀致，格式不匹配将报

错。
8. TIMESTAMPtimestamp需要按照yyyy-[m]m-[d]d hh\:mm\:ss[.f...]格式存储为

字符串。
9. BOOLEANtrue or false字符串。
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• 复合类型
1. ARRAY需存储为JSON数组，数组元素按照本⽂约定规则转换成字符串，数组元素⽀持任意

类型。
2. MAP需存储为JSON对象，map key、value按照本⽂约定规则转换为字符串，value⽀持任

意类型嵌套。
3. STRUCT需存储为JSON对象， struct字段名为string，转换为JSON对象的key， struct字

段值转换为JSON对象的value，字段值以本⽂定义规则转换。
⽰例
• array类型

对于如下所⽰表结构：
列名 列数据类型
c_1 ARRAY<TINYINT>
c_2 ARRAY<INT>
c_3 ARRAY<FLOAT>
c_4 ARRAY<DATETIME>
c_6 ARRAY<TIMESTAMP>
c_7 ARRAY<STRING>

可通过下⾯所⽰csv格式导⼊数据：

c_1,c_2,c_3,c_4,c_6,c_7
"[""1"",""2"",""3""]","[""1"",""2"",""3"",""4""]","[""1.2"",""2.0
""]","[""2017-11-11 00:00:00"",""2017-11-11 00:00:00"",""2017-11-11
 00:00:00""]","[""2017-11-11 00:00:00.123456789"",""2017-11-11 00:00
:00.123456789"",""2017-11-11 00:00:00.123456789""]","[""aaa"",""bbb
"",""ccc""]"
"[""1"",""2"",""3""]","[""1"",""2"",""3"",""4""]","[""1.2"",""2.0
""]","[""2017-11-11 00:00:00"",""2017-11-11 00:00:00"",""2017-11-11
 00:00:00""]","[""2017-11-11 00:00:00.123456789"",""2017-11-11 00:00
:00.123456789"",""2017-11-11 00:00:00.123456789""]","[""aaa"",""bbb
"",""ccc""]"
"[""1"",""2"",""3""]","[""1"",""2"",""3"",""4""]","[""1.2"",""2.0
""]","[""2017-11-11 00:00:00"",""2017-11-11 00:00:00"",""2017-11-11
 00:00:00""]","[""2017-11-11 00:00:00.123456789"",""2017-11-11 00:00
:00.123456789"",""2017-11-11 00:00:00.123456789""]","[""aaa"",""bbb
"",""ccc""]"

说明:
CSV格式需要对双引号进⾏转义，通过两个双引号来表⽰双引号，具体可参考CSV格式规范。
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• map类型
对于如下所⽰表结构：
列名 列数据类型
c_1 MAP<TINYINT,STRING>
c_2 MAP<STRING,INT>
c_3 MAP<FLOAT,STRING>
c_4 MAP<STRING,DATETIME>
c_5 MAP<STRING,STRING>
c_6 MAP<TIMESTAMP,STRING>

可通过下⾯所⽰csv格式导⼊数据：

c_1,c_2,c_3,c_4,c_5,c_6
"{1:""2345""}","{""123"":""2"",""3"":""4""}","{2.0:""223445"",1.2
:""1111""}","{""aaa"":""2017-11-11 00:00:00"",""ccc"":""2017-11-11
 00:00:00"",""bbb"":""2017-11-11 00:00:00""}","{""ckey"":""cvalue
""}","{""2017-11-11 01:00:00.123456789"":""dddd"",""2017-11-11 00:00
:00.123456789"":""aaa"",""2017-11-11 00:01:00.123456789"":""ddd""}"
"{1:""2345""}","{""123"":""2"",""3"":""4""}","{2.0:""223445"",1.2
:""1111""}","{""aaa"":""2017-11-11 00:00:00"",""ccc"":""2017-11-11
 00:00:00"",""bbb"":""2017-11-11 00:00:00""}","{""ckey"":""cvalue
""}","{""2017-11-11 01:00:00.123456789"":""dddd"",""2017-11-11 00:00
:00.123456789"":""aaa"",""2017-11-11 00:01:00.123456789"":""ddd""}"
"{1:""2345""}","{""123"":""2"",""3"":""4""}","{2.0:""223445"",1.2
:""1111""}","{""aaa"":""2017-11-11 00:00:00"",""ccc"":""2017-11-11
 00:00:00"",""bbb"":""2017-11-11 00:00:00""}","{""ckey"":""cvalue
""}","{""2017-11-11 01:00:00.123456789"":""dddd"",""2017-11-11 00:00
:00.123456789"":""aaa"",""2017-11-11 00:01:00.123456789"":""ddd""}"

• struct类型
对于如下所⽰表结构：
列名 列数据类型
c_struct <RUCT<x:INT,y:VARCHAR(256),z:

STRUCT<a:TINYINT,b:STRING>>
可通过下⾯所⽰csv格式导⼊数据：

c_struct
"{""x"":""1000"",""y"":""varchar_test"",""z"":{""a"":""123"",""b
"":""stringdemo""}}"
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"{""x"":""1000"",""y"":""varchar_test"",""z"":{""a"":""123"",""b
"":""stringdemo""}}"

2.4.3 可视化创建、修改和删除表
Studio的project explorer提供了可视化表结构编辑器，可进⾏创建、修改表。

可视化建表
操作步骤
1. 右击需要创建表的project，选择Create a new table:
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2. 弹框⾥填写对应的表名、列等信息，然后点击Generate CreateTable Statement⽣成对应
的DDL语句，点击Execute,执⾏建表。

表/列名、⽣命周期、列类型等限制请遵循MaxCompute相关要求，可参⻅表操作。

说明:
studio可视化建表并没有选择flag的设置，默认使⽤以下两个flag:
a. odps.sql.submit.mode ：script

b. odps.sql.type.system.odps2：true

3. 表创建成功后，可以在Project Explorer的table&view查看到元数据，若找不到请Refresh
meta。
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可视化修改表
操作步骤
1. 在Project Explorer的table&view列表中，右击需要修改的表，选择Open table editor:

44 ⽂档版本：20190701



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

2. 弹框中对表进⾏编辑，可以修改表comments、lifecycle，修改列名、列描述,新增列。具体规
则遵循MaxCompute table相关要求，可参看表操作。

3. 填写完成修改项后，点击Alter Table Statement ⽣成具体的Alter语句，点击Execute执⾏表
修改操作。执⾏成功可以对表的元数据进⾏查看。

可视化删除表
在Project Explorer的table&view列表中，右击需要修改的表,选择Drop table from server:
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弹框中选择OK即可将表从MaxCompute服务上删除。

2.5 开发SQL程序
2.5.1 创建MaxCompute Script Module

开发MaxCompute Script前，需要创建⼀个MaxCompute Script Module，创建时存在以下两
种情况：

本地没有script⽂件
本地没有script⽂件时，可通过Intellij创建⼀个全新的Module。
操作步骤
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1. 打开或者新建⼀MaxCompute Studio Project。本⽂以新建为例，单击菜单栏中的File，导航
⾄New > Project 。如下图所⽰：
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2. 选择左侧导航栏中的MaxCompute Studio，单击Next 。
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3. 填写Project Name，单击Finish。

说明:
如果之前有打开的Project，将会提⽰您是否在当前窗口中打开（即关掉之前的Project），选
择This Window。

⽂档版本：20190701 49



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

4. 创建完成后，⻚⾯如下图所⽰，您即可在此项⽬中开发SQL脚本。

本地已有script⽂件
假如本地某个⽂件夹下已经有很多script，此时需要⽤MaxCompute studio来编辑这些 script
，您可直接打开⼀个Module。
操作步骤
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1. 在scripts⽂件夹下创建⼀个MaxCompute的连接配置⽂件 odps_config.ini，在⾥⾯配置
与MaxCompute连接的鉴权信息：
• project_name=xxxxxxxx
• access_id=xxxxxxxxxx
• access_key=xxxxxxxxx
• end_point=xxxxxxxxx
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2. 打开IDEA，导航⾄File > open， 选择您的scripts⽂件夹。

3. MaxCompute Studio会探测该⽂件夹下是否存在odps_config.ini⽂件，根据这个⽂件⾥
的配置信息抓取服务端的meta，然后编译⽂件夹下的所有script。
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2.5.2 编写SQL脚本
MaxCompute Studio模块创建完成后，即可开始编写MaxCompute SQL脚本。

操作步骤
1. 右击scripts ，导航⾄New > MaxCompute Script 。
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2. 填写弹出框中的相关内容，点击OK。

• Script Name：脚本名称。
• Script type：脚本类型。
• Target Project：⽬标MaxCompute项⽬。单击后⾯的+即可新建⼀个MaxCompute

Project，配置详情请参⻅ 新建项⽬空间连接。
3. 在SQL⽂件编辑界⾯中，编写SQL。

说明:
a. 实际SQL请根据⾃⼰的MaxCompute Project中的表进⾏编写。可单击toolbar右上

⻆切换绑定的不同的MaxCompute项⽬，也⽀持跨project资源依赖。例如script绑定
了ProjectA，同时还会⽤到ProjectB.table1，这时Studio会⾃动使⽤ProjectA的账号去
抓取ProjectB的元数据。表的元数据Studio会保存在本机中类似下图的位置：
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b. 新建sql script时的代码模板是可以在Intellij Preferences⻚修改的：

MaxCompute Studio功能
MaxCompute Studio不仅提供语法⾼亮，智能提醒，错误提⽰，还⽀持以下功能：
• schema annotator： 当⿏标悬停在表上，可显⽰其schema。悬停在列上，可显⽰其类

型；悬停在函数上，可显⽰其签名。
• code folding： 可以将⼦查询等折叠起来，⽅便⻓SQL的阅读。
• brace matching：⿏标单击⾼亮左括号，其匹配的右括号也会⾼亮，反之亦然。
• go to declaration：按住Ctrl键，单击table ，即可查看table详情。单击function ，即可显

⽰其源码。
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• code formatting：⽀持对当前脚本格式化，快捷键（Ctrl + Alt + L）。可在如下⻚⾯⾃定义
格式化规则，譬如关键字⼤小写，是否换⾏等。

• code inspect：⽀持对当前脚本进⾏代码检查，某些检查还会提供quick fix，可通过快捷
键Alt + Enter唤出。另外，可在Settings > Editor > Inspections  > MaxCompute处修改某
条规则。

• find usages：选中editor中的某张表（或函数），右键菜单选Find Usages ，则会在当
前IntelliJ project下寻找所有使⽤该表的脚本。

• live template：Studio内置了⼀些SQL live template，可以在编辑器中使⽤Ctrl + J
(Command + J on Mac OS X) 快捷键唤出（例如忘记了insert into table的语法，便可唤
出live template popup后搜索insert table）。

56 ⽂档版本：20190701



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

• builtin documentation：⽀持在系统内置函数处通过Ctrl + Q（Ctrl + J on Mac OS X）唤
出帮助⽂档。

• sql history：所有通过studio提交运⾏的sql我们都记录在本地了，你可以点击toolbar上的图
标，弹出sql history窗口，查询你曾经执⾏过的SQL。

详细的SQL编写命令介绍请参⻅表操作。
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2.5.3 提交SQL脚本
MaxCompute Studio可直接将MaxCompute SQL提交到服务端运⾏，并显⽰查询结果，执⾏计
划等详细信息。它在提交前会进⾏编译，能够有效避免提交到服务端后才发现编译错误。

前提条件
• ⾸先创建MaxCompute项⽬连接，并绑定⽬标项⽬。
• 创建 MaxCompute Studio Module。
• 在提交前需根据⾃⾝需求进⾏相关设置。MaxCompute Studio提供了丰富的设置功能，可

在Editor编辑⻚⾯上⽅的Tool Bar⼯具栏中快速设置。设置主要分为以下三种：
- 编辑器模式：编译器模式设定包括两种模式，脚本模式和单步模式。

■ 单步模式会将提交的脚本⽂件按；分隔，逐条提交到服务端执⾏。
■ 脚本模式为最新开发模式，可将整条脚本⼀次提交到服务端，由服务端提供整体优化，效

率更⾼，推荐使⽤。
- 类型系统：类型系统主要解决 SQL 语句的兼容性问题，分为以下三种类型：

■ 旧有类型系统：原有 MaxCompute 的类型系统。
■ MaxCompute 类型系统：MaxCompute 2.0 引⼊的新的类型系统。
■ Hive 类型系统：MaxCompute 2.0 引⼊的 Hive 兼容模式下的类型系统。

- 编译器版本：MaxCompute Studio提供稳定版编译器和实验性编译器两种模式：
■ 默认编译器：稳定版本。
■ 实验性编译器：包含编译器最新特性。

说明:
脚本提交设置可采⽤全局设定，导航⾄File > Settings > MaxCompute ，选
择MaxCompute SQL，其中Compiler > Submit中可以设置以上属性。

提交SQL脚本
Editor上⽅⼯具栏中提供同步，编译，提交功能。
* **同步功能**：更新SQL脚本中使⽤的元数据，包括表名、UDF等。如果Studio提⽰表或函数找不到，而服务端⼜明确存在时，可尝试使⽤该功能更新元数据。
* **编译、提交**：按MaxCompute SQL预发规则编译或提交到服务端，编译错误会在
MaxCompute Compiler窗口中显⽰详细信息。

具体操作
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1. 编写好SQL语句后，单击⼯具栏或侧边栏上的绿⾊运⾏图标，或者右键Script Editor，选
择Run MaxCompute SQL Script，即可提交到服务端。当SQL中存在变量时（如下图
的${bizdate}），会弹出对话框，提⽰您输⼊变量值。

在您的SQL任务运⾏前，IDEA会向您提⽰预估的SQL费⽤。

⽂档版本：20190701 59



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

2. SQL会先被本地编译(依赖于你在Project Explore窗口中添加的项⽬元数据)，⽆编译错误后
就会提交到服务端执⾏。SQL执⾏过程中会显⽰运⾏⽇志，当已经开始在服务端运⾏时，会打
开job detail⻚，显⽰作业运⾏的基本信息以及执⾏图：

3. 可以在结果⻚查看SQL结果，单句模式下当存在多条语句时，会显⽰每条语句的结果。可以选择
表格中的⼀些⾏或列，Ctrl + C到剪切板中。
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2.6 开发Java程序
2.6.1 创建MaxCompute Java Module

MaxCompute Studio能⽀持⽤⼾开发Java UDF和MR，⾸先需要新建⼀个MaxCompute Java
Module。

创建module
依次单击File > new > module，module类型为MaxCompute Java，配置Java JDK。单
击next，输⼊module名，单击finish。studio会帮⽤⼾⾃动创建⼀个maven module，并引
⼊MaxCompute相关依赖，具体请查看pom⽂件。

module结构说明
⾄此，⼀个能开发MaxCompute Java程序的module已建⽴，如下图的mDev。主要⽬录包括:
• src/main/java：⽤⼾开发java程序源码。
• examples：⽰例代码，包括单测⽰例，⽤⼾可参考这⾥的例⼦开发或编写UT。
• warehouse：本地运⾏时需要的schema和data。
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2.6.2 开发和调试UDF
创建完成MaxCompute Java Module 后，即可开发UDF。

操作步骤
1. 展开已创建的MaxCompute Java Module⽬录，导航⾄src > main > java > new，单

击MaxCompute Java 。如下图所⽰：
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2. 填写name和kind，单击OK 。如下图所⽰：

• Name：填写创建的MaxCompute Java Class名称，如果还没创建package，可以在此处
填写 packagename.classname，会⾃动⽣成package。

• Kind：选择类型。⽬前⽀持的类型有：⾃定义函数（UDF/UDAF/UDTF）、MapReduce
（Driver/Mapper/Reducer）、⾮结构化开发（StorageHandler/Extractor）等。

3. 创建成功后，即可进⾏开发、编辑、测试Java程序。

说明:
这⾥的代码模板可在Intellij中⾃定义，具体的：Preference > Editor > File  > Code
Templates，然后在Code标签⻚中寻找MaxCompute对应的模板修改。

通常情况下，JAVA UDF的开发可以通过以下⼏种⽅式：
• 使⽤MaxCompute Studio完成JAVA UDF开发整个流程。
• 使⽤Eclipse插件开发和调试JAVA UDF，导出Jar包，然后通过命令或者DataWorks添加资源后

再注册函数。
了解详细开发步骤，请参⻅开发Java UDF#可选#。
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调试UDF
开发UDF完成后，即可通过单元测试和本地运⾏两种⽅式进⾏测试，看是否符合预期。
单元测试
在examples⽬录下有各种类型的单元测试⽰例，可参考⽰例编写⾃⼰的Unit Test。

本地运⾏
本地运⾏UDF时，需要指定运⾏数据源，有以下两种⽅式设定测试数据源：
• MaxCompute Studio通过Tunnel服务⾃动下载指定项⽬下的表数据到warehouse⽬录下。
• 提供Mock项⽬及表数据，您可参考warehouse下的example_project⾃⾏设置。
操作步骤

⽂档版本：20190701 65



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

1. 右击UDF类，单击运⾏，弹出run configuration对话框。UDF/UDAF/UDTF⼀般作⽤
于select⼦句中表的某些列，需要配置MaxCompute project，table和column（元数据来源
于project explorer和warehouse下的Mock项⽬）。复杂类型的调试也是⽀持的，如下图：

2. 单击OK。

说明:
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• 如果指定项⽬下的表数据未被下载到warehourse中，需要先下载数据，默认下载100条。
默认下载100条，如需更多数据，可配置Download record limit项。

• 如果采⽤Mock项⽬或已下载数据，则直接运⾏。
• UDF的local run框架会将warehouse中指定列的数据作为UDF的输⼊，开始本地运⾏

UDF，您可以在控制台看到⽇志输出和结果打印。
本地warehouse⽬录
本地warehouse⽤于存储表（包括meta和数据）或资源，⽤于本地执⾏UDF或MR。
warehouse⽬录如下图所⽰：

说明:
• warehouse⽬录下依次是项⽬名，tables，表名，表schema和sample data。
• schema⽂件依次配置项⽬名，表名，以及列名和类型（冒号分隔），分区表还需配置分区

列（⾮分区表参考wc_in1，分区表参考wc_in2）。

⽂档版本：20190701 67



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

• data⽂件采⽤标准csv格式存储表的sample数据：
- 特殊字符为逗号，双引号和换⾏（\n或\r\n）
- 列分隔符为逗号，⾏分隔符为\n或\r\n
- 如果列内容⾥包含特殊字符，需要在该列内容前后加上双引号，例如：3,No -> “3, No”
- 如果列内容包含双引号，则每个双引号转义成两个双引号，例如：a”b”c -> “a””b

””c”
- \N表⽰该列为null，如果该列内容（string 类型）就是\N，需要转换为 “””\N”””
- ⽂件字符编码为UTF-8

2.6.3 开发MapReduce
创建完成 MaxCompute Java Module后，即可以开始开发MR了。

开发MR
1. 在Module的源码⽬录即src > main上右键new > java，选择MaxCompute Java。
2. 分别创建Driver、Mapper、Reducer。
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3. 模板已⾃动填充框架代码，只需要设置输⼊/输出表，Mapper/Reducer类等即可。

开发MR详情请参⻅编写MapReduce#可选#。
调试MR

MR开发好后，下⼀步就是要测试⾃⼰的代码，看是否符合预期，⽬前⽀持以下两种⽅式：
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• 单元测试：在examples⽬录下有WordCount的单测实例，可参考例⼦编写⾃⼰的UT。
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• 本地运⾏MR：本地运⾏时，需要指定运⾏数据源，有两种⽅式设定测试数据源：
- Studio通过Tunnel服务⾃动下载指定MaxCompute Project的表数据到warehouse⽬录

下。默认下载100条，如需更多数据测试，请⾃⾏使⽤Console的Tunnel命令或者Studio的
表下载功能。

- 提供mock项⽬（example_project）及表数据，⽤⼾可参考warehouse下example_pr

oject⾃⾏设置。
1. 运⾏MR：在Driver类上右键，点击运⾏菜单，弹出run configuration对话框，配置MR需

要在哪个MaxCompute Project上运⾏即可。

2. 单击OK，如果指定MaxCompute Project的表数据未被下载到warehouse中，则⾸先下
载数据；如果采⽤mock项⽬或已被下载则跳过。MR Local Run框架会读取warehouse中
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指定表的数据作为MR的输⼊，开始本地运⾏MR。⽤⼾可以在控制台看到⽇志输出和结果打
印。

⽣产运⾏MR
本地调试通过后，把MR发布到服务端，在MaxCompute分布式环境下运⾏MR。
1. ⾸先，将⾃⼰的MR程序打成jar包，并发布到服务端。详细操作步骤请参⻅打包、上传和注册。
2. 通过MaxCompute Console（⽆缝集成于Studio），打开Project Explorer Window，右键

单击project，选择Open in Console，可在Console命令⾏中输⼊类似如下的jar命令。
jar-libjars wordcount.jar -classpath D:\odps\clt\wordcount.jar com.
aliyun.odps.examples.mr.WordCount wc_in wc_out;

详细命令输⼊参请⻅jar命令。
2.6.4 ⾮结构化开发

MaxCompute2.0新增了⼀套⾮结构化数据处理框架，⽀持通过外部表的⽅式直接访
问OSS、OTS等。Studio对此提供了⼀些代码模板⽀持，⽅便⽤⼾快速开发。

编写StorageHandler/Extractor/Outputter
1. 创建MaxCompute Java Module(在examples⽬录下的unstructured⽂件夹有⽰例代码供参

考)。
2. 在module的源码⽬录即src > main上右键new > java，选择MaxCompute Java。
3. 输⼊包名.类名，如myun.MyExtractor，选择类型Extractor，点击OK。
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4. 模板已⾃动填充框架代码，只需要编写⾃⼰的逻辑代码即可。
5. 类似上述步骤可分别完成Outputter和StorageHandler的编写。

单元测试
可参考examples⽬录下的例⼦编写unit test，测试⾃⼰的Extractor/Outputter。

打包上传
StorageHandler/Extractor/Outputter写好后，可以参考打包发布将已写好的java程序打
成jar包，并作为resource上传到服务端。
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创建外部表
1. 在scripts⽬录右键new > MaxCompute Script。

2. 输⼊SQL脚本名，Target Project选择脚本将要在哪个MaxCompute project下执⾏，点
击OK。
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3. editor中唤出create external table live template，能快速插⼊创建外部表脚本模板：

然后修改外部表名称、列及类型、StorageHanlder类路径、配置参数、外部路径、jar名
等，修改完成后点击运⾏脚本，创建该外部表。

4. 接下来，就可以查询该外部表了，类似：
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2.6.5 开发Graph
创建完成 MaxCompute Java Module后，即可以开始开发Graph了。

代码⽰例
在examples⽬录下有graph的⼀些代码⽰例，可参考⽰例熟悉Graph程序的结构。

编写Graph
1. 在module的源码⽬录即src > main > java上右键new，选择MaxCompute Java。
2. 选择GraphLoader/Vertex等类型，Name框中输⼊类名(⽀持包名.类名)。点击OK，模板会⾃

动填充框架代码，可在此基础上继续修改。

本地调试Graph
Graph开发好后，下⼀步就是要测试⾃⼰的代码，看是否符合预期。我们⽀持本地运⾏Graph，具
体的：
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1. 运⾏Graph: 在驱动类(有main函数且调⽤GraphJob.run⽅法)上右键，点击运⾏菜单，弹
出run configuration对话框，配置Graph需要在哪个MaxCompute Project上运⾏即可。

2. 点击OK，如果指定MaxCompute project的表数据未被下载到warehouse中，则⾸先
下载数据；如果采⽤mock项⽬或已被下载则跳过。接下来，graph local run框架会读
取warehouse中指定表的数据作为输⼊，开始本地运⾏Graph，⽤⼾可以在控制台看到⽇志输
出。每运⾏⼀次本地调试，都会在Intellij⼯程⽬录下新建⼀个临时⽬录，⻅下图：

说明:
关于warehouse的详细介绍请参考开发UDF中本地warehouse⽬录部分。
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⽣产运⾏Graph
本地调试通过后，接下来就可以把Graph发布到服务端，在MaxCompute分布式环境下运⾏了:
1. ⾸先，将⾃⼰的Graph程序打成jar包，并发布到服务端。如何打包发布?

2. 通过Studio⽆缝集成的MaxCompute Console（在Project Explorer Window的Project上
右键，选择Open in Console），在Console命令⾏中输⼊类似如下的 jar命令：
jar -libjars xxx.jar -classpath /Users/home/xxx.jar com.aliyun.odps.
graph.examples.PageRank pagerank_in pagerank_out;

更详细的Graph开发介绍请参⻅编写Graph#可选#。
2.6.6 打包、上传和注册

完成UDF或 MR开发后，需要打包发布到MaxCompute系统。
打包UDF或MR

⼀个UDF或MR要想发布到服务端供⽣产使⽤，要经历打包 > 上传 > 注册三个步骤。针对此，我
们提供了⼀键发布功能（studio会依次执⾏mvn clean package，上传jar和注册UDF三个
步骤，⼀次完成）。具体的，在UDF或MR类上右键(该类必须在src > main > java⼦⽬录
下，maven module⾥编译成功)，选择Deploy to server… 菜单，会弹出如下对话框，选择要部
署的MaxCompute project，输⼊资源名和函数名，点击ok等待后台完成即可。

说明:
当然，如果你有特殊的打包需求，那么你可以⾃⾏修改pom.xml打包相关配置。打好包后，再依
次⼿⼯操作如下的上传jar和注册UDF即可。

上传jar
打包成功后，就可以将该jar包上传到MaxComptute服务端:
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1. 在MaxCompute菜单选择Add Resource菜单项。

2. 选择要上传到哪个MaxCompute project上，jar包路径，要注册的资源名，以及当资源或函数
已存在时是否强制更新，然后点击OK。

3. 上传成功后，可以在project explorer窗口的resources节点下看到该资源。

注册UDF
jar包上传完成后，就可以注册UDF函数了。

⽂档版本：20190701 79



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

1. 在MaxCompute菜单选择Create Function菜单项。

2. 选择需要使⽤的资源jar、jar的主类，输⼊函数名，然后点击OK。

3. 注册成功后，可以在project explorer窗口的functions节点下看到该函数。

80 ⽂档版本：20190701



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

使⽤UDF
• 接下来就可以在SQL中使⽤新编写的UDF完成后续开发。

2.7 开发Python程序
2.7.1 Python开发使⽤须知

MaxCompute Studio⽀持您在Intellij IDEA中完成Python相关的开发，包括UDF和PyODPS脚
本，但使⽤前必须安装Python、PyODPS和IDEA的Python插件。
在开始Python项⽬开发前，我们需要下载相关版本的Python配置Python环境变量。本⽂使⽤的
Python版本为Python2.7。

安装PyODPS
PyODPS是MaxCompute的PyODPS SDK，详情请参⻅Python SDK。
在Windows环境下，请务必在File > Settins > MaxCompute Studio保证您的Python安装路径
设置正确，⽤于解析Python UDF，举例如下。
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安装Python插件
在Intellij IDEA的插件仓库中搜索Python或者Python Community Edition插件并安装。
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配置Python依赖
配置Studio Module对Python的依赖，即可进⾏MaxCompute Python的开发。
1. 导航⾄File > Project Structure，添加Python SDK。

2. 导航⾄File > Project Structure，添加Python Facets。
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3. 导航⾄File > Project Structure，配置Module依赖Python Facets。

2.7.2 开发Python UDF
MaxCompute Studio⽀持Python UDF开发，但需要您做好准备⼯作。

开发
1. 右键单击New > MaxCompute Python。

说明:
如果没有MaxCompute Python选项说明没有Python插件，请确认是否安装成功。配置和安
装过程请参⻅Python开发使⽤须知。
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2. 输⼊类名，如Hello，选择类型，此处选择Python UDF。填写完成后单击OK。

3. 模板已⾃动填充框架代码，您只需要编写UDF的⼊参出参，以及函数逻辑。

测试
UDF开发完成后，需要测试⾃⼰的代码，看是否符合预期。我们⽀持下载表的部分sample数据到
本地运⾏，进⾏DeBug，操作如下：
1. 右键单击Editor中的UDF类，单击RUN，弹出Run/Debug Configurations对话框。

说明:
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UDF|UDAF|UDTF⼀般作⽤于Select⼦句中表的某些列，此处需配置MaxCompute
project、table和columns，元数据来源于project explorer窗口和warehouse下的Mock
项⽬。

2. 单击OK后，通过Tunnel⾃动下载您指定表的sample数据到本地warehouse⽬录。

说明:
• 如果已经下载过，则不会再次重复下载，否则利⽤Tunnel服务下载数据。
• 默认下载100条，如果需要更多数据测试，请⾃⾏使⽤console的Tunnel命令或者Studio

的表下载功能。
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3. 下载完成后，您可以在warehouse⽬录看到下载的sample数据。您也可以使⽤Mock
data（即warehouse中的数据⾃⼰mock，详情请参⻅开发和调试UDF中的斜斜斜斜斜warehouse

斜斜模块。

4. 本地运⾏框架会根据您指定的列，获取data⽂件中指定列的数据，调⽤UDF本地运⾏。

说明:
本地运⾏是通过Pyodps的pyou脚本实现的，命令如pyou hello.Plus<data。安装
完pyodps后可以使⽤相应的命令检查该脚本是否存在。
• 如果您是windows系统，请运⾏${python}/../Scripts/pyou。
• 如果您是mac系统，请运⾏${python}/../pyou。

您可以在控制台看到结果打印，也可以在UDF上打断点调试。

注册发布
Python UDF测试通过后，即可注册发布到⽣产上进⾏使⽤。Add Resource后，Create
Function即可。详情请参⻅打包、上传和注册。
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2.7.3 开发PyODPS脚本
PyODPS是MaxCompute Python版本的SDK， 它提供了对MaxCompute对象的基本操作，并
提供了DataFrame框架，您可以在MaxCompute上进⾏数据分析。

开发PyODPS脚本
1. 使⽤PyODPS开发脚本，⾸先需要安装PyODPS及Python插件，安装完成后即可直接新建⼀

个MaxCompute PyODPS脚本。

⽂档版本：20190701 89



MaxCompute ⼯具及下载 /  2 MaxCompute Studio

2. 新建成功后，模板会通过PyODPS room对象，⾃动初始化odps和o这两个对象。

说明:
在公共云Dataworks上运⾏时会⾃动在后台创建，所以为了IDEA编译通过，需要显式创建。

2.8 管理MaxCompute作业
2.8.1 作业浏览

通过Studio可以⽅便查看当前⽤⼾提交的MaxCompute的运⾏实例，包括运⾏状态、作业类型、
起⽌时间等。

打开Job Explorer
如果Job Explorer View没有在左侧Dock上显⽰，可以通过View > Tool Windows > Job
Explorer 打开。
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查看项⽬下所有作业实例
Job Explorer⽀持按照状态查询提交的作业列表，如下图所⽰，查看过去24小时内执⾏失败的作
业：
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单击⽇期筛选框，选择其他⽇期，拖动选择时间。如下图。

点击刷新按钮获取作业列表。

说明:
默认只显⽰符合条件的前1000条作业，若超过1000条的作业将⽆法显⽰，请考虑更新过滤条件。

作业列表排序
可以通过点击job列表的列名对job进⾏简单排序，如下图按提交时间倒序：

作业排队队列
活动状态作业如果正在排队队列中等待调度，作业列表中会展⽰当前排队的位置和全局优先级：
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说明:
在Running Instances Tab下的作业状态、队列位置等会⾃动更新，作业结束后会从列表中移
除。

作业⽇志保存功能
⽬前job的logview⽇志默认保存7天，有些重要的logview希望能保留更⻓时间以便后期进⾏查
看，可以将logview保存到本地：
双击列表中的job，在右侧打开job的详细信息，点击⼯具栏上的save按钮，将⽇志保存到本地：

若需要⾃定义保存⽂件的⽬录，可以在Studio的Setting配置项中进⾏配置：
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2.8.2 作业实例详情
查看作业实例

Studio⽀持两种⽅式查看MaxCompute作业实例。
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1. 通过Logview URL或本地的logview离线⽂件以只读⽅式打开作业详情。
使⽤Logview来查看⼀个作业的详细信息是MaxCompute⽤⼾熟悉的⽅式。使⽤Logview还
有⼀个便利之处是可以查看其他⽤⼾在其他项⽬空间中提交的任务状态。Studio提供通过输⼊
⼀个有效的Logview URL打开任意⼀个作业详情的功能。
在菜单栏中，打开MaxCompute菜单下的Open Logview，即可⾃动将粘贴板中有
效Logview URL地址复制到弹出窗口中或者选择导出在本地的logview离线⽂件。

2. 作业浏览信息中，选择某个MaxCompute实例，双击或右键Open，可查看该实例详细信息。
作业详情视图

作业详情⻚⾯包括顶部的⼯具栏，左半部分的基本属性栏以及右半部分详细视图⻚，其中详细视图
⻚主要包含四个视图：
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• 执⾏图：以DAG图的⽅式显⽰作业整体信息，可查看⼦任务间依赖关系及各个⼦任务的详细执
⾏计划。

• 时序图：显⽰作业执⾏timeline，可以从不同粒度查看执⾏的时序,并提供了多种过滤器。
• 详情：以table view⽅式展⽰作业详细信息，包括⼦任务列表，各⼦任务的worker列

表，worker处理数据量，执⾏时间及状态信息等。
• 脚本：显⽰该作业提交时所对应的SQL语句以及提交作业的参数配置信息。
• 概要（JSON）：以JSON格式显⽰作业运⾏详细信息。
• 结果视图：显⽰该作业运⾏结果。
• 分析：提供作业执⾏散点图、⻓尾柱状图及数据倾斜图。

⼯具栏
⻚⾯左右折叠

⽤来收起或完全展开左右侧视图，允许⽤⼾最⼤化某⼀个视图进⾏查看。
停⽌作业
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⽤来中断正在执⾏的作业，需要具有响应权限才能停掉作业（owner或管理员）。
刷新详情

对于运⾏中的作业，它的基本信息，如状态、quota等会⾃动刷新，但右侧各个详情视图不会⾃动
刷新，如果想要获取最新详情信息，需要⼿动刷新。
拷⻉logview

复制作业对应的logview到剪切板。
在浏览器打开作业详情

⽣成logview URL，并通过浏览器打开。
作业详情保存到本地

将作业详情信息保存为本地⽂件。
⾃动刷新
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对于运⾏中作业，允许⾃动刷新后，studio会对作业执⾏全量定时刷新。
基本信息⻚

展⽰作业基本信息，包括ID、Owner、状态、起⽌时间、计算资源⽤量, 输⼊输出等。运⾏中作业
的基本信息会⾃动定时刷新。输⼊，输出项列出了作业的输⼊表和输出表，双击表名可查看对应表
详情。

执⾏图
执⾏图作为⽇常主要使⽤⼯具，以可视化的⽅式展⽰Fuxi Job， FuxiTask以及Operation的依赖
关系，同时提供⼀系列辅助⼯具，如作业回放，进度图，热度图等，绝对是排查问题的好帮⼿。
执⾏图可展⽰三个维度的作业依赖关系：Fuxi Job层， Fuxi Task层， Operation层，可点击⾯
包屑或向上箭头进⾏切换，默认会展⽰Fuxi Task层依赖关系。

说明:
⾮SQL类型作业，仅能展⽰Fuxi Job和Fuxi Task层作业，不⽀持Operation层。
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说明:
对应序号说明如下：
1. 可点击跳转其他层次
2. 缩放辅助⼯具
3. 依赖表
4. Fuxi Task节点
5. 鹰眼
6. 展⽰
7. 默认打开FuxiTask层依赖
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• Fuxi Job层:
单击MaxCompute Job或在Fuxi Task层中点击向上箭头即可打开Fuxi Job层。Fuxi Job节点
内包含Fuxi Task名称，起⽌时间等。双击任⼀Fuxi Job节点即可进⼊Fuxi Task层。

• Fuxi Task层：
当有多个Fuxi Job时，默认打开最后⼀个Fuxi Job的Fuxi Task层。该层可展⽰Fuxi Task的依
赖关系，输⼊输出表及分区等信息。当作业结束后点击⼯具栏中下拉框可切换进度图，输⼊热度
图，输出热度图，Task时间热度图，Instance热度图等。进度图表⽰节点的完成进度，热度图
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通过颜⾊区分节点热度。双击任⼀Fuxi Task即可打开Operation层，右键可以展开所有Fuxi 
Task的Operation层。

Fuxi Task节点内容：

1.Instance Count：a/b/c, 指某⼀时刻正在运⾏⼦任务实例个数为a，已结束任务实例个数b，总任务实例个数c。
2.I/O records：同理为某⼀时刻的input records和output records。
3.百分⽐与橙⾊进度条：表⽰该任务运⾏情况，该⽐例根据⼦任务运⾏实例分析得出。
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4.⼦任务间连线上显⽰的是输出records数量。箭头表⽰数据流动⽅向。

• Operation层
Operation层揭⽰了Fuxi Task内在的运⾏⽅式，单击任⼀节点即可显⽰Operaiton完整信息。

作业回放
Studio⽀持作业回放功能，作业回放就像播放媒体⽂件⼀样，可在12s内回顾该Job执⾏的历史轨
迹。该功能主要⽤于帮助⽤⼾了解MaxCompute实例在不同时刻运⾏状态，快速判断⼦任务级运
⾏顺序及消耗时间，掌握Job执⾏关键路径，从而针对运⾏较慢的⼦任务进⾏优化。
• 点击 > 按钮即可开始播放，再次点击则暂停。⽤⼾也可⼿动拖动进度条。
• 进度条左边为作业开始时间，中间为播放时间，右边为结束时间。
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说明:
回放功能仅通过时间估算某⼀个时刻IO数据量，从而确定完成进度，并不能代表该时刻真实IO数
据量。Running 状态作业不⽀持回放功能。

时序图
以⽢特图的⽅式展⽰作业分布式执⾏的详细数据，可以调整展⽰粒度，将每⼀个计算节点都在⽢特
图中展⽰。

可以通过⽢特图直观的看出作业运⾏的时间瓶颈、⻓尾节点等。同时提供多种过滤器，能够直接筛
选出作业执⾏的关键路径、最⼤数据节点、最⻓时间节点等。

详情⻚
主要针对SQL DML类作业，展⽰作业在计算集群上的Fuxi Task列表、计算节点列表等
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说明:
对应序号说明如下：
1. Fuxi Job Tab
2. Fuxi Task列表
3. 每个Fuxi Task详细信息及计算节点列表

通常⼀个作业对应⼀个或多个Fuxi job，每个Fuxi job拆分成多个Fuxi task（阶段）,每个Fuxi 
task包含多个Fuxi instance（worker）。
在每个Fuxi instance通过右键菜单可以查看作业运⾏的标准输出、标准错误，及Debug Info。
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分析⻚
展⽰作业的⻓尾节点(worker)、数据倾斜节点(worker)。展⽰节点散点图、及柱状图，辅助作业
执⾏瓶颈诊断

散点图和柱状图⽀持从图中节点直接调准详情⻚查看Fuxi instance详情。
结果⻚

结果⻚会根据作业类型及提交作业时的参数设置展⽰不同⻚⾯。
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• select语句并且设置odps.sql.select.output.format = HumanReadable ，select以⽂本⽅
式展⽰

• select语句并且未设置output format参数，结果以table⽅式展⽰
• 对于数据输出到表的脚本，展⽰输出表名及到表详情的跳转链接
• 对于异常作业，结果⻚限制异常详情

2.9 ⼯具集成
2.9.1 与MaxCompute客⼾端集成

MaxCompute Studio集成了MaxCompute客⼾端程序，可在Studio中直接打开客⼾端。
配置客⼾端安装路径

1. Studio中已包含最新版MaxCompute客⼾端程序，并指定为默认客⼾端。⽤⼾也可⾃⾏指定其
他版本客⼾端程序，单击file > Settings > MaxCompute Studio > SDK & Console，添加客
⼾端程序和路径。
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2. 设置成功后会显⽰MaxCompute客⼾端版本信息。

打开MaxCompute客⼾端
设置MaxCompute客⼾端安装路径成功后，就可以在Studio中打开客⼾端程序。
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1. 在项⽬浏览列表中，选中要打开的项⽬，右键菜单中点击Open in Console。

2. ⽤⼾可以打开多个客⼾端程序，操作步骤同上。

2.10 配置选项
2.10.1 配置 MaxCompute Studio

安装 MaxCompute Studio 插件后，可以在 IntelliJ IDEA 的 Setting ⻚⾯的左边栏找到
MaxCompute Studio 的配置项。打开 IntelliJ 配置⻚⾯的⽅法请参考 IntelliJ 的⽂档。

MaxCompute Studio 配置选项⻚
MaxCompute Studio 配置选项⻚提供以下配置项：
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1. 本地元数据仓库存储路径
指定在本地存储 MaxCompute 项⽬空间元数据的路径。Studio 的缺省设置是本地⽤⼾⽬录下
的.odps.studio/meta 这个隐含⽬录。

2. 版本更新选项
• 复选框 Automatically checks for new version 可以控制 Studio 是否⾃动检查新版本更

新
• 按钮 Check new versions ⽤于⼿动检查新版本。 点击检查新版本按钮后，如果有新版本可

以更新，将显⽰ Install new version 按钮，点击可以安装，安装完成后需要重启 IntelliJ
IDEA。

SDK & Console 配置选项⻚
SDK & Console 配置选项⻚⾯提供以下配置项：
1. MaxCompute 客⼾端安装路径

指定本地安装的 MaxCompute 客⼾端的安装路径。 Studio 会检测路径中安装的 
MaxCompute 客⼾端的版本，如果检测失败，会提⽰错误信息。

说明:
Studio 2.6.1 之后的版本⾃带了最新的 MaxCompute 客⼾端，⽤⼾不⽤特别指定。 如果⽤⼾
希望使⽤⾃⼰特定版本的 MaxCompute客⼾端，可以指定路径。

MaxCompute SQL 配置选项⻚
MaxCompute SQL 配置选项⻚⾯提供以下配置项：
1. 启动语法⾼亮

勾选Enable syntax coloring 选项，启动语法⾼亮功能。
2. 启动代码⾃动补全

勾选Enable code completion 选项，启动代码⾃动补全功能。
3. 启动代码格式化

勾选Enable code formatting 选项，启动代码格式化功能。
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4. 编译器选项
在这⾥这是全局缺省的编译器选项。 以下选项还可以在 SQL 编辑器的⼯具栏上为每个⽂件单独
设置。
• 编译器模式（Compiler Mode）

- 单句模式（Statement Mode）：在该模式下，编译器对 SQL ⽂件单条语句作为单元进
⾏编译、提交

- 脚本模式（Script Mode）：在该模式下，编译器对整个 SQL ⽂件作为单元进⾏编译、
提交。 #注#脚本模式有利于编译器和优化器更⼤程度地优化执⾏计划#提⾼整体执⾏效
率#⽬前处于测试阶段#

• 类型系统
- 旧有类型系统（Legacy TypeSystem）：原有 MaxCompute 的类型系统
- MaxCompute 类型系统（MaxCompute TypeSystem）：MaxCompute 2.0 引⼊的

新的类型系统
- Hive 类型系统（Hive Compatible TypeSystem）：MaxCompute 2.0 引⼊的 Hive

 兼容模式下的类型系统
• 编译器版本

- 默认编译器（Default Version）：默认版本的编译器，
- 实验性编译器（Flighting Version）：实验性的版本的编译器，包含正在测试中的编译

器的新特性
Account 配置选项⻚

Account 配置选项⻚⾯提供添加和管理⽤⼾⽤于访问 MaxCompute 所⽤账⼾，参考 ⽤⼾认证：
Studio 需要通过⽤⼾指定的账号访问 MaxCompute 的项⽬空间和执⾏提交作业等操作，⽬前 
Studio ⽀持的账号类型有：
• 阿⾥云账号（AccessKey）
添加账⼾
在 Account 配置选项⻚⾯，执⾏以下步骤：
1. 点击按钮 + 或者快捷键 Ctrl-N
2. 选择账⼾类型 Aliyun Account by AccessKey
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3. 在弹出的 Add Account 窗口中填⼊:
• Account Name： 该账⼾在 Studio 中的标识名称。
• Using properties file: 从配置⽂件中读取 AccessKey ID 和 AccessKey Secret。

- 选择⼀个在 ⽤⼾认证 中 conf/odps_config.ini ⽰例的配置⽂件。
• Using properties： ⼿动填⼊ AccessKey ID 和 AccessKey Secret。

- Access Id： 填⼊⽤⼾阿⾥云账号的 AccessKey ID。
- Access Key：填⼊⽤⼾阿⾥云账号的 AccessKey Secret。

4. 点击按钮 OK 完成添加。 添加完成后账号会出现在 Account 配置选项⻚⾯的 Account 列表
⾥。

删除账⼾
在 Account 配置选项⻚⾯，执⾏以下步骤（该操作仅在 Studio 配置中删除账⼾配置，对⽤⼾账⼾
本⾝不产⽣影响）：
1. 在 Account 列表中选择要删除的账⼾名称。
2. 点击按钮 -。
3. 在弹出的的确认对话框中，选择OK 。
修改账⼾ AccessKey
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在 Account 配置选项⻚⾯，执⾏以下步骤：
1. 在 Account 列表中选择要删除的账⼾名称。
2. 点击”铅笔”图标进⾏编辑。
3. 在弹出的 Edit Account 窗口中编辑 Account 信息，内容与上⾯的Add Account 窗口类似。
查看MaxCompute Region的开通情况和连接⽅式及Endpoint的设置，请参⻅配置Endpoint。

2.11 Studio视频介绍
• Studio 安装介绍
• 通过Studio管理数据
• 通过Studio编辑SQL

• Studio SQL Scripting

• 通过Studio开发UDF

• 通过Studio remote debug

• 通过Studio查看所有job

2.12 常⻅问题（FAQ）
2.12.1 如何通过 Studio 开发 UDF

本⽂介绍如何通过studio来开发MaxCompute Java UDF。
1. 新增⼀个module: 参考创建MaxCompute java module，我们的UDF代码将放置在

此module中。
2. 开发UDF: 参考UDF开发 studio提供了UDF开发模板，你可以依据模板完成UDF开发。
3. 测试: studio提供了UDF本地调试的机制，你可以参考UDF test模板编写⾃⼰的测试⽤例。
4. 打包: 你可以依赖IDE本⾝提供的打包功能，将⾃⼰的UDF源码打包成jar。
5. 注册发布: 在打好jar包后，需要先添加资源，随后注册函数。注册成功后就可以

在MaxCompute project explorer窗口的functions节点下查看该UDF，同时也可以
在script editor⾥使⽤该UDF。
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2.12.2 如何通过 Studio 管理 MaxCompute 元数据
MaxCompute⽤⼾在⽇常使⽤过程中，需要浏览管理所在project的meta（包括表，函数和资
源），我们来看看如何通过Studio来⽅便的管理操作。
• 如何新增⼀个project连接: 参考新增连接 通过MaxCompute project explorer新建⼀

个MaxCompute project连接，连接连通性测试成功后，就可以看到刚才新增的project节点
树。

• 如何查看table列表及schema: 参考浏览meta 展开project下的tables & views能看
到table和view列表，展开具体的某个table能看到列和类型。

• 如何查看function代码: 展开functions能看到function列表，展开具体的某个function能看
到⽅法签名，双击该function即可以看到反编译的源码。

• 如何查看下载表的sample数据: 参考导⼊导出表数据 双击某个table就能看到详细
的schema，还能预览sample数据，在data preview窗格中右键Export grid data。你也可
以直接在节点树的表名上右键export。

• 如何更新节点的meta: 譬如某个表新增了⼀列，你可以在选中该表后右键refresh meta或点
击⼯具栏上的refresh按钮，即可以看到新增的这⼀列了。⼜譬如project下新建了⼀些表，选
中tables & view后点击⼯具栏上的refresh按钮即可以看到新建的这些表了。

• 如何对表做DDL操作: 删除是可以直接批量操作的，选中表后，右键Delete table from
server即可。新增和编辑还不⽀持直接通过界⾯操作，你可以通过在editor⾥编写相应
的DDL语句来完成。
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3 Eclipse开发插件
3.1 安装Eclipse插件

本⽂向您介绍如何在Eclipse安装MaxCompute插件。
为了⽅便您使⽤ MapReduce 及UDF的Java SDK进⾏开发⼯作，MaxCompute（原 ODPS）提
供了Eclipse开发插件。该插件能够模拟MapReduce及UDF的运⾏过程，为您提供本地调试⼿
段，并提供了简单的模板⽣成功能。

说明:
• ⽬前⾼版本的Eclipse Neon有可能会导致插件加载失败，请使⽤Eclipse Luna版本。
• 请单击 此处 下载插件。
• 与MapReduce提供的本地运⾏模式不同，Eclipse插件不能够与MaxCompute同步数据。您

使⽤的数据需要⼿动拷⻉到Eclipse插件的warehouse⽬录下。
下载Eclipse插件后，将软件包解压，会看到如下Jar内容：
odps-eclipse-plugin-bundle-0.16.0.jar

将插件放置在Eclipse安装⽬录的plugins⼦⽬录下。打开Eclipse，单击右上⻆的打开透视
图（Open Perspective），如下图。
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单击后出现对话框，如下图。
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选择ODPS，单击OK 。同样在右上⻆会出现ODPS图标，表⽰插件⽣效。如下图。
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3.2 创建MaxCompute⼯程
本⽂为您介绍在Eclipse中创建MaxCompute⼯程的两种⽅式。

⽅式⼀
1. 在左上⻆选择⽂件(File)  > 新建(New) > Project > ODPS > ODPS Project，创建⼯程（⽰例

中使⽤ODPS作为⼯程名）。
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2. 创建MaxCompute⼯程后会出现如下对话框。输⼊Project name，选择MaxCompute客⼾
端的安装路径（客⼾端需要提前下载），并确认（单击Finish）。

说明:
关于MaxCompute客⼾端的介绍请参⻅客⼾端 。
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3. 创建好⼯程后，在左侧包资源管理器（Package Explorer）中可以看到⽬录结构。
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⽅式⼆
1. 直接单击左上⻆的新建。
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2. 弹出对话框后，选择ODPS Project，单击下⼀步。

3. 后续操作同⽅式⼀。
MaxCompute Eclipse插件安装结束后，您可以使⽤此插件编写MapReduce或者UDF程序。
关于插件中对MapReduce的功能介绍请参⻅MapReduce开发插件介绍，UDF的程序编写请参
⻅UDF开发插件介绍。

3.3 MapReduce开发插件介绍
本⽂向您介绍如何使⽤Eclipse开发和运⾏MapReduce程序。
选择ODPS项⽬中的WordCount⽰例，如下图。
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右键单击WordCount.java，依次单击Run As > ODPS MapReduce，如下图。

弹出对话框后，选择example_project，单击确认，如下图。
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运⾏成功后，会出现结果提⽰，如下图。
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运⾏⾃定义MapReduce程序
右键选择src⽬录，选择新建(New) > Mapper ，如下图。
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选择Mapper后出现下⾯的对话框。输⼊Mapper类的名字，并确认。如下图。
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会看到在左侧包资源管理器(Package Explorer)中，src⽬录下⽣成⽂件UserMapper.java。该
⽂件的内容即是⼀个Mapper类的模板，如下图。
package odps;
import java.io.IOException;
import com.aliyun.odps.data.Record;
import com.aliyun.odps.mapred.MapperBase;
public class UserMapper extends MapperBase {
    @Override
    public void setup(TaskContext context) throws IOException {
    }
    @Override
    public void map(long recordNum, Record record, TaskContext context
)
            throws IOException {
    }
    @Override
    public void cleanup(TaskContext context) throws IOException {
    }
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}

模板中，将package名称默认配置为“odps”，⽤⼾可以根据⾃⼰的需求进⾏修改。编写模板内
容，如下图。
package odps;
import java.io.IOException;
import com.aliyun.odps.counter.Counter;
import com.aliyun.odps.data.Record;
import com.aliyun.odps.mapred.MapperBase;
public class UserMapper extends MapperBase {
    Record word;
    Record one;
    Counter gCnt;
    @Override
    public void setup(TaskContext context) throws IOException {
          word = context.createMapOutputKeyRecord();
          one = context.createMapOutputValueRecord();
          one.set(new Object[] { 1L });
          gCnt = context.getCounter("MyCounters", "global_counts");
    }
    @Override
    public void map(long recordNum, Record record, TaskContext context
)
            throws IOException {
          for (int i = 0; i < record.getColumnCount(); i++) {
              String[] words = record.get(i).toString().split("\\s+");
              for (String w : words) {
                word.set(new Object[] { w });
                Counter cnt = context.getCounter("MyCounters", "
map_outputs");
                cnt.increment(1);
                gCnt.increment(1);
                context.write(word, one);
              }
            }
          }
    @Override
    public void cleanup(TaskContext context) throws IOException {
    }
}

同理，右键选择src⽬录，选择新建(New) > Reduce，如下图。

⽂档版本：20190701 127



MaxCompute ⼯具及下载 /  3 Eclipse开发插件

输⼊Reduce类的名字(本⽰例使⽤UserReduce):
同样在包资源管理器(Package Explorer)中，src⽬录下⽣成⽂件UserReduce.java。该⽂件的
内容即是⼀个Reduce类的模板。编辑模板，如下图。
package odps;
import java.io.IOException;
import java.util.Iterator;
import com.aliyun.odps.counter.Counter;
import com.aliyun.odps.data.Record;
import com.aliyun.odps.mapred.ReducerBase;
public class UserReduce extends ReducerBase {
    private Record result;
    Counter gCnt;
    @Override
    public void setup(TaskContext context) throws IOException {
          result = context.createOutputRecord();
          gCnt = context.getCounter("MyCounters", "global_counts");
    }
    @Override
    public void reduce(Record key, Iterator<Record> values, TaskContex
t context)
            throws IOException {
          long count = 0;
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          while (values.hasNext()) {
            Record val = values.next();
            count += (Long) val.get(0);
          }
          result.set(0, key.get(0));
          result.set(1, count);
          Counter cnt = context.getCounter("MyCounters", "reduce_out
puts");
          cnt.increment(1);
          gCnt.increment(1);
          context.write(result);
        }
    @Override
    public void cleanup(TaskContext context) throws IOException {
    }
}

创建main函数: 右键选择src⽬录，选择新建(New) > MapReduce Driver。
填写Driver Name(⽰例中是UserDriver)，Mapper及Recduce类(⽰例中
是UserMapper及UserReduce)，并确认。同样会在src⽬录下看到MyDriver.java⽂件，如下
图。
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编辑driver内容，如下图。
package odps;
import com.aliyun.odps.OdpsException;
import com.aliyun.odps.data.TableInfo;
import com.aliyun.odps.examples.mr.WordCount.SumCombiner;
import com.aliyun.odps.examples.mr.WordCount.SumReducer;
import com.aliyun.odps.examples.mr.WordCount.TokenizerMapper;
import com.aliyun.odps.mapred.JobClient;
import com.aliyun.odps.mapred.RunningJob;
import com.aliyun.odps.mapred.conf.JobConf;
import com.aliyun.odps.mapred.utils.InputUtils;
import com.aliyun.odps.mapred.utils.OutputUtils;
import com.aliyun.odps.mapred.utils.SchemaUtils;
public class UserDriver {
    public static void main(String[] args) throws OdpsException {
        JobConf job = new JobConf();
        job.setMapperClass(TokenizerMapper.class);
        job.setCombinerClass(SumCombiner.class);
        job.setReducerClass(SumReducer.class);
        job.setMapOutputKeySchema(SchemaUtils.fromString("word:string
"));
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        job.setMapOutputValueSchema(SchemaUtils.fromString("count:
bigint"));
        InputUtils.addTable(
            TableInfo.builder().tableName("wc_in1").cols(new String[]
 { "col2", "col3" }).build(), job);
        InputUtils.addTable(TableInfo.builder().tableName("wc_in2").
partSpec("p1=2/p2=1").build(), job);
        OutputUtils.addTable(TableInfo.builder().tableName("wc_out").
build(), job);
        RunningJob rj = JobClient.runJob(job);
        rj.waitForCompletion();
    }
}

运⾏MapReduce程序，选中UserDriver.java，右键选择Run As > ODPS MapReduce ，点击
确认。出现对话框，如下图。
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选择ODPS Project为：example_project，单击Finish按钮开始本地运⾏MapReduce程序，如
下图。

有如上输出信息，说明本地运⾏成功。运⾏的输出结果在warehouse⽬录下。关于warehouse的
说明请参考本地运⾏ 。刷新ODPS⼯程，如下图。
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wc_out即是输出⽬录，R_000000即是结果⽂件。通过本地调试，确定输出结果正确后，可以通
过Eclipse导出(Export)功能将MapReduce打包。打包后将jar包上传到ODPS中。在分布式环境
下执⾏MapReduce，详情请参考 快速⼊⻔ 。
本地调试通过后，⽤⼾可以通过Eclipse的Export功能将代码打成jar包，供后续分布式环境使⽤。
在本⽰例中，我们将程序包命名为mr-examples.jar。选择src⽬录，单击Export，如下图。

选择导出模式为Jar File，如下图。
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仅需要导出src⽬录下package(com.aliyun.odps.mapred.open.example)，Jar File名称指定
为mr-examples.jar，如下图。
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确认后，导出成功。
如果⽤⼾想在本地模拟新建Project，可以在warehouse下⾯，创建⼀个新的⼦⽬录(与
example_project平级的⽬录)，⽬录层次结构，如下图。
<warehouse>
   |____example_project(项⽬空间⽬录)
          |____ <__tables__>
          |       |__table_name1(⾮分区表)
          |       |      |____ data(⽂件)
          |       |      |
          |       |      |____ <__schema__> (⽂件)
          |       |
          |       |__table_name2(分区表)
          |            |____ partition_name=partition_value(分区⽬录)
          |            |          |____ data(⽂件)
          |            |
          |            |____ <__schema__> (⽂件)
          |
          |____ <__resources__>
                  |
                  |___table_resource_name (表资源)
                  |         |____<__ref__>
                  |
                  |___ file_resource_name（⽂件资源）

schema⽂件⽰例，如下图。
⾮分区表:
project=project_name
table=table_name
columns=col1:BIGINT,col2:DOUBLE,col3:BOOLEAN,col4:DATETIME,col5:STRING分区表:
project=project_name
table=table_name
columns=col1:BIGINT,col2:DOUBLE,col3:BOOLEAN,col4:DATETIME,col5:STRING
partitions=col1:BIGINT,col2:DOUBLE,col3:BOOLEAN,col4:DATETIME,col5:
STRING注：当前⽀持5种数据格式:bigint,double,boolean,datetime,string， 对应到java中的数据类型-long,double,boolean,java.util.Date,java.lang.String。

data⽂件⽰例，如下图。
1,1.1,true,2015-06-04 11:22:42 896,hello world
\N,\N,\N,\N,\N注：时间格式精确到毫秒级别，所有类型⽤\N表⽰null。

说明:
• 本地模式运⾏MapReduce程序，默认情况下先到warehouse下查找相应的数据表或资源，如

果表或资源不存在会到服务器上下载相应的数据存⼊warehouse⽬录下，再以本地模式运⾏。
• 运⾏完MapReduce后，请刷新warehouse⽬录，才能看到⽣成的结果。
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3.4 UDF开发插件介绍
在本章节我们将介绍如何使⽤Eclipse插件开发并在本地运⾏UDF。UDAF、UDTF的编写执⾏过
程与UDF类似，均可参考UDF的⽰例介绍完成。ODPS Eclipse插件提供两种运⾏UDF的⽅式：菜
单栏和右键单击快速运⾏⽅式。

菜单栏运⾏
1. 从菜单栏选择Run > Run Configurations…弹出如下对话框：
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2. ⽤⼾可以新建⼀个Run Configuration，选择运⾏的UDF类及类型、选择ODPS Project、填
写输⼊表信息，如：

上述配置中，Table表⽰UDF的输⼊表，Partitions表⽰读取某个分区下的数据，分区由逗
号分隔，Columns表⽰列，将依次作为UDF函数的参数被传⼊，列名由逗号分隔。

3. 单击Run运⾏，运⾏结果将显⽰在控制台中：
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右键单击快速运⾏
1. 选中⼀个udf.java⽂件（⽐如：UDFExample.java）并单击⿏标右键，选择Run As > Run

UDF|UDAF|UDTF。
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2. 配置信息如下：

上述配置中，Table表⽰UDF的输⼊表，Partitions表⽰读取某个分区下的数据，分区由逗
号分隔，Columns表⽰列，将依次作为UDF函数的参数被传⼊，列名由逗号分隔。

3. 单击Finish后，运⾏UDF，获得输出结果。
运⾏⽤⼾⾃定义UDF程序

右击⼀个⼯程并选择New > UDF（或者选择菜单栏File > New > UDF)。
填写UDF类名然后单击Finish。在对应的src⽬录下⽣成与UDF类名同名的Java⽂件，编辑
该java⽂件内容：
package odps;
import com.aliyun.odps.udf.UDF;
public class UserUDF extends UDF {
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      /**
       * project: example_project 
       * table: wc_in1 
       * columns: col1,col2
       * 
       */
      public String evaluate(String a, String b) {
        return "ss2s:" + a + "," + b;
      }
}

右击该java⽂件（如UserUDF.java），选择Run As，再选择ODPS UDF|UDTF|UDAF:

配置如下对话框：
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单击Finish，得出结果：
ss2s:A1,A2
ss2s:A1,A2
ss2s:A1,A2
ss2s:A1,A2

本⽰例中仅给出UDF的运⾏⽰例，UDTF的运⾏⽅式与UDF基本相同，不做特殊说明。

3.5 Graph开发插件介绍
创建ODPS项⽬后，⽤⼾可以编写⾃⼰的Graph程序，参照下⽂步骤操作完成本地调试。
在此⽰例中，我们选⽤插件提供的PageRank.java来完成本地调试⼯作。选中examples下的
PageRank.java⽂件，如下图。
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右键单击，选择Debug As > ODPS MapReduce|Graph，如下图。

单击后出现对话框，作如下配置。
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查看作业运⾏结果，如下图。
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可以查看在本地的计算结果，如下图。

调试通过后，⽤⼾可以将程序打包，并以Jar资源的形式上传到ODPS，并提交Graph作业。

说明:
• 程序打包过程以及有关本地结果的⽬录结构介绍，请参⻅MapReduce开发插件介绍。
• 关于上传Jar资源的详细介绍，请参⻅资源操作中创建Jar资源部分。
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• 有关提交Graph作业的操作，请参⻅Graph功能介绍中Jar命令的介绍。
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4 相关下载
本⽂将为您提供在使⽤MaxCompute过程中，可能⽤到的相关⼯具及插件的下载地址。
• SDK下载信息：如果您使⽤Maven，可以从Maven库中搜索odps-sdk，获取不同版本的Java

SDK。
• 新版客⼾端：点击此处即可下载新版客⼾端。
• Eclipse开发插件：点击此处即可下载 Eclipse开发插件。
• IntelliJ开发插件：IDEA⼯具点击此处 ，Studio插件点击此处即可下载 IntelliJ开发插件。
• JDBC：MaxCompute提供开源JDBC，您可以在GitHub下载JDBC，也可以在云栖社区查看发

布信息或提问。
• PHP SDK：您可以在GitHub下载。
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https://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/cn/odps/0.0.90/assets/download/odps-eclipse-plugin-bundle-0.16.0.zip
https://www.jetbrains.com/idea/?spm=5176.doc50891.2.4.2O5djt
https://plugins.jetbrains.com/plugin/9193-maxcompute-studio
https://github.com/aliyun/aliyun-odps-jdbc/releases
https://yq.aliyun.com/articles/72791
https://yq.aliyun.com/articles/72791
https://github.com/aliyun-beta/aliyun-odps-php-sdk
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